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An Overview XE "Introduction"  of Microsoft Office OneNote 2003
The Microsoft® Office OneNote™ 2003 note-taking program, a member of the Microsoft Office System of pro​ducts, provides users with a powerful new way to capture, organize and share notes. With OneNote on your desktop, laptop or Tablet PC,  XE "Tablet PC:Support for..." you can collect and consoli​date all your notes and ideas in a single location — one that you can organize and reorganize to meet your unique needs. OneNote provides tools for incorporating text, pictures and drawings — as well as audio and video files that you can annotate in real time. You can save these notes for future reference, share them with colleagues or friends, and send them via e‑mail to others (including those who are not OneNote users).
Stepping Beyond Pen and Paper
OneNote is designed to enhance the everyday act of note-taking and facilitate the integration of your notes and ideas into the electronically enabled fabric of our lives. OneNote gives you a digital medium in which to do the following:
· Take notes and capture ideas as easily and flexibly as you can with pen and paper
· Organize and reorganize information easily
· Find information quickly — even when there’s a lot of it to sift through
· Use, reuse and share notes efficiently and effectively
Because you can do all this in a digital medium, OneNote helps you become more productive. Rather than taking the time to transcribe paper-based meeting notes or scan drawings into electronic format, for example, you can use OneNote to capture your notes electronically from the outset — so they are ready for distribution as soon as the meeting concludes. Add to that the ability to insert diagrams, graphics, 
hyper​links and information dragged right off the Web, and your notes are transformed from things that pile up unused and forgotten into knowledge that you and others can tap into as easily as you do any other well-connected information resource. 
OneNote Highlights XE "Highlights"  
OneNote makes it easy to move from paper to PC for capturing, organizing and sharing your notes. Consider the following advantages:

· You can use OneNote on any desktop, laptop or Tablet PC system that meets the minimum system requirements (see page 2). 
· You can click anywhere on the OneNote page to start entering your notes, and then you can reposition your notes on the page later if you want. 
· OneNote enables you to add emphasis to notes with bullet and list styles as well as distinct Note Flags and highlighting; it also provides full control over note text fonts, styles, sizes and colors.
· You can organize your notes with a flexible hierarchy of nested folders, sections and pages that you control to meet your needs.
· You can search your entire notebook instantly to find notes on specific subjects.

· You can share your notes using e‑mail, by posting your notes as HTML code to a Web site, by posting your notes to a Microsoft Windows® SharePoint™ Services site, and even through peer-to-peer networking sessions that enable multiple users to interact with (or just view) your notes in real time.

· If you use a Tablet PC, OneNote will recognize the system’s digital pen, so you can draw diagrams and enter handwritten notes which you can convert to text or leave as handwriting.  XE "Tablet PC:Handwriting and drawing support" 

 XE "Ink:Converting to text" 
New Features in Microsoft OneNote SP1

The release of Microsoft Office OneNote 2003 SP1 includes significant new features, including these:

· Video recording and note synchronization (see page 2)
· Pocket PC and Smartphone support (see page 2)
· Real-time shared notebooks (see page 2)
· Screen-region capture (see page 2)
· Password protection (see page 2)
· Enhanced file import capabilities (see page 2)
· Enhanced integration with Microsoft Office 2003 (see page 2)
In addition, SP1 enhances many existing OneNote features. With SP1, you can do the following:
· Customize pens 

· Add more pen colors 

· Change date on pages 

· Create subpage titles
· Drag and drop files into OneNote, with improved link handling 

· Insert date/time into a page 
· Resize page tabs 

· Work with shared folders more easily

· Use more Note Flags 

· Work with more stationery 

· Search better 

· Set up pages more flexibly 

Need more information on Microsoft Office OneNote 2003? Visit the OneNote Web site at http://www.microsoft.com/office/onenote/ for the latest information and updates.

Capture Information More Efficiently
We are a world of note takers. We jot on napkins and in spiral notebooks, on graph paper and sticky pads. Intuitively we know that information coming at us in real time, from across a desk, telephone line or lecture hall, is fleeting, possibly lost if we do not make a record of its passing. 
Yet how effectively do we really capture the information streaming past us? How well do we capture our thoughts about — and responses to — the information we hear? The reality is, we often fail to capture information accurately, and just as often we fail to capture more than a fragment of a complete idea. Finally, all too often our notes in their raw form are not broadly usable. You can’t share a drawing on a dinner napkin with a distant colleague using e‑mail. You can’t publish your paper-based notes to a shared Web site. You can’t search a stack of spiral notebooks instantly to find out what your English professor said about The Great Vowel Shift. 
OneNote changes all this. OneNote has been designed to help you capture, organ​ize and share information more effectively and efficiently than ever. With OneNote, you could do the following:
· Record and take notes on an important presentation, and then share both the recording and your linked notes using e‑mail or a SharePoint site
· Search your entire collection of notes — and instantly find your notes on The Great Vowel Shift (or anything else you took notes about)
· Sketch your design ideas on your Tablet PC rather than paper — and share your drawing with a colleague on another continent using e‑mail 

OneNote gives you all the flexibility you have enjoyed when using a pencil and paper but delivers that flexibility in a digital format, which opens up a whole new world of note-taking power. 
Type Notes Anywhere XE “How to…:Get started taking notes" 
With a pencil and paper, you can place your pencil anywhere you want on the page and start taking notes. OneNote provides the same flexibility. Click anywhere on the OneNote page surface, and you can start taking notes (see Figure 1).
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Figure 1: Type notes anywhere on the screen.
With OneNote you can group related notes together on a page. For example, before a meeting you might create an area for notes titled Agenda, a second area titled Attendees and a third titled To Do. During the meeting, you can quickly add  XE “How to…:Add notes" relevant notes to any of those three areas — or click elsewhere on the page to start a completely new group of notes. You can even  XE “How to…:Move notes" move the individual note areas —called “containers” in OneNote — by clicking on a container’s handle (notice the gray bar on the top of the To-Do list in Figure 1) and dragging it elsewhere on the page. By dragging one container to another container, you can combine containers, and by selecting specific text in one container and dragging it away from that container you can split one container into two. You can also cut or copy a container and paste it on another page altogether.
A Rich Environment for Taking Notes
 XE “How to…:Format notes" OneNote enhances the note-taking experience with rich authoring and word-processing features.  XE “OneNote capabilities:Formatting text" You can format note text using different fonts and sizes, as well as bold, italic and underline styles.  XE “OneNote capabilities:Bulleted lists" 

 XE “OneNote capabilities:Numbered lists" You can highlight text and apply colors to text; you can use a variety of bulleted and numbered list styles. As a member of the Microsoft Office System, OneNote makes use of your existing  XE “OneNote capabilities:AutoCorrect entries" 

 XE “OneNote capabilities:Spell checking" AutoCorrect entries and spelling checking tools (including any personal dictionaries you have created). You will experience this rich authoring experience in every container of notes.
The added advantages of OneNote become even more apparent when your note-taking involves more than text. You can  XE “OneNote capabilities:Dragging and dropping graphics" drag graphics from your desktop, an open application or an open Web site right onto a OneNote page and position them wherever you want (see Figure 2). You can also  XE “OneNote capabilities:Cut and paste from other applications" cut and paste information from other OneNote pages and other Microsoft Office System applications, including these: 
· Pictures and text from Microsoft Office Word documents XE "Integration:With Microsoft Office Word" 
· Graphs, charts, text or even entire slides from Microsoft Office PowerPoint® presentations XE "Integration:With Microsoft Office PowerPoint" 
· Columns and rows of numbers and charts from Microsoft Office Excel sheets XE "Integration:With Microsoft Office Excel" 
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Figure 2: Copy and paste information from almost anywhere.
Indeed, you can paste into OneNote virtually anything that can be captured using the standard cut and paste features of the Microsoft Windows environment, including links to other files and Web sites.  XE “OneNote capabilities:Cut and paste from other applications"  XE "Linking to other files and websites" When you copy and paste information from a Web site to a OneNote page, the source URL is automatically inserted with the 
infor​mation, so you can click the link and quickly return to the source of the information if you need to.  XE “OneNote capabilities:Hyperlinks"  XE "OneNote capabilities:Linking to other files and websites" This feature lets you conduct research more efficiently by capturing all of the information you need in one place.
When you copy and paste handwritten digital ink  XE "Ink:Support for" 

 XE "Ink:Converting to text"  XE "Ink:Converting to graphics" notes created in OneNote on a Tablet PC XE "Tablet PC:Handwriting and drawing support"  into other programs, the handwriting is automatically converted to text. Drawings are pasted as picture files.  XE “OneNote capabilities:Handwriting conversion"  XE “OneNote capabilities:Drawing conversion" 
Screen Region Capture  XE “OneNote capabilities:Screen region capture" 

 XE “How to…:Capture information from my screen” 
OneNote even makes it easy for you to capture a portion of your screen and place it in a OneNote page. You might want to capture the contents of several windows on your desktop, for example, and OneNote provides a Screen Region Capture tool that makes it easy to capture that portion of your screen and save it as a graphic. You can launch the Screen Region Capture feature by right-clicking the OneNote icon in the system tray area of the taskbar. If OneNote is al​ready open, you can launch Screen Region Capture from the Insert menu of OneNote itself. When launching the Screen Region Capture tool from within OneNote, the OneNote window itself is minimized to reveal the other open windows. 
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Figure 3: The Screen Region Capture tool enables you to select a portion of your screen and save it as a graphic in OneNote.

Side notes
 XE “OneNote features:Side notes" 

 XE "Side notes" 

 XE "What are…:Side notes" Sometimes you need to capture informa​tion on the fly, such as when you are on the phone, doing research or working with another application. The side note fea​ture in OneNote enables you to do just that (see Figure 4). 
You can open a streamlined, smaller view of OneNote using a keyboard shortcut (Windows key+N or Ctrl+Shift+M), or by right-clicking the OneNote icon in the sys​tem tray. This small window gives you access to all the functionalities of OneNote, but in a smaller display format called a side note. 
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Figure 4: The OneNote side note makes it easy to make notes on the fly.
By default, a OneNote side note hovers above any other application running on your system, and you can “pin” the note to any part of the screen. This is a great way to keep pertinent information or reminders on hand — it’s like a “sticky note” for the PC with all the powerful features of OneNote. And you can open as many side notes as you want. You can “unpin”  XE “How to…:Cause a OneNote window to hover above other open windows” the side note by clicking the pin icon in the task bar, which causes the side note to slip behind the window of another application when that application is active. If you enlarge a side note window, it opens into the familiar OneNote notebook.  XE “How to…:Convert a side note window to a standard OneNote window” 
Using side notes is a convenient way to capture thoughts or information while working in other applications, too. For example, you might pin a side note on top of an open Web browser and drag information from a Web site into the side note (see Figure 4).  XE “OneNote capabilities:Automatic save" As with any other note in OneNote, the information you capture in a side note is automati​cally saved. You’ll find each side note beneath the OneNote section tab called Side notes.
Research Task Pane
Sometimes when taking notes, you need to look up a word or get a better 
under​standing of an idea or concept. The Research Task  XE “OneNote capabilities:Access to reference materials" Pane (see Figure 5) provides access to  XE “How to…:Access a dictionary, thesaurus, or encyclopedia” dictionaries, thesauruses, encyclopedias and  XE “OneNote capabilities:Translation services" 

 XE “How to…:Access translation services” translation services — all from within OneNote. You can look up  XE “How to…:Access business and financial information” 

 XE “OneNote capabilities:Access to business and financial information" business and financial information, search through intranet reference sites (if your network has them), and do  XE “OneNote capabilities:Web searches" 

 XE “How to…:Search the Web from within OneNote” Web searches using MSN® Search, and then incorporate that information directly into your notes.
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Figure 5: The OneNote Research Task Pane
Recording Audio and Video Notes
Notes are often brief summaries of ideas or discussions. However, sometimes brevity ends up being ambiguous. You may not always remember what a particular word or phrase means. Or you may have a difficult time deciphering a particular handwritten note. Sometimes your notes refer to visual phenomena, and you may find yourself wondering just what you were witnessing when you made a particular note. 
OneNote takes notes into a new realm by enabling you to record linked Audio and Video Notes, which are particularly valuable when you don’t want to miss anything that someone says or does. 
Recording Audio Notes XE “How to…:Record audio” 
 XE "Audio support:Recording" If you have a microphone connected to your computer — and most portable 
com​puters today have built-in microphones — you can record audio by clicking the Record Audio Only button in the Standard toolbar. OneNote makes a note of when the audio recording starts (see the Agenda container in Error! Reference source not found.), and as you make notes on the page,  XE "Audio support:Linking notes to an audio recording" OneNote synchronizes your notes to the audio itself.  XE “OneNote capabilities:Synchronizing written notes with recorded audio" By doing this, OneNote tracks the audio that occurred at the exact moment each note was typed or written. 
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Figure 6: Recording linked audio ensures that you won't miss important items

 XE “OneNote capabilities:Audio playback" 

 XE "Audio support:Audio playback" If you need to clarify a certain note, you can hover your mouse cursor over the note in question, and an icon of a speaker will appear (see the Agenda container in Error! Reference source not found.). Click on this icon, and OneNote plays the audio that occurred when that note was taken. You can also listen to the entire audio by clicking on the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video toolbar. If the  XE “OneNote capabilities:Tracking audio playback against your notes" See Playback button is selected in the Audio and Video toolbar, OneNote will highlight the appropriate sections of your notes as the audio progresses. If you connect your PC to your phone — all it takes is an inex​pensive adaptor — you can record conference calls and link your notes to that audio as well.

Recording Video Notes XE “OneNote capabilities:Audio and Video Recording" \r "AudioVideoRecording"  XE “How to…:Record video" 
 XE "Video support:Recording" If you have a digital video camcorder or webcam attached to your computer, you can record video (and audio, if you have a microphone) by clicking the Record Video button in the Standard toolbar. OneNote makes a note of when the video recording starts, and as you make notes on the page, OneNote synchronizes your notes to the video you are recording XE “OneNote capabilities:Synchronizing written notes with recorded video" . By doing this, OneNote keeps track of the video recorded when each note was typed or written. If you need to clarify a certain note, you can hover your mouse cursor over the note in question and an icon of a speaker will appear.  XE “OneNote capabilities:Video playback" 

 XE "Video support:Video playback" Click on the icon, and OneNote replays the video recorded when the note was taken. You can also replay the entire video by clicking on the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video toolbar. If the  XE “OneNote capabilities:Tracking video playback against your notes" See Playback button is selected in the Audio and Video Recording toolbar, OneNote will highlight the appropriate sections of your notes as the video progresses.
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Figure 7: OneNote synchronizes your notes to the video you are recording.
Capturing Handwritten Notes and Drawings
 XE “OneNote capabilities:Working with handwriting" \r “HandwritingSupport”

 XE “OneNote capabilities:Working with drawings" \r “HandwritingSupport”

 XE “OneNote capabilities:Tablet PC support" If you have a Tablet PC XE "Tablet PC:Handwriting and drawing support" \r “HandwritingSupport”  or a desktop or laptop computer with a pen input device,  XE “OneNote capabilities:Support for digital pen input (non-Tablet PC)"  you can use your digital pen to take handwritten notes or draw pictures and diagrams in OneNote (see Figure 8). If you are using a Tablet PC, you can convert your handwriting to text (or leave it as handwriting, if you prefer); if you are not using a Tablet PC, OneNote recognizes your handwriting as a graphic, which cannot be 
con​verted to text.  XE "Ink:Support for" \r "HandwritingSupport" 
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Figure 8: With OneNote you can write notes by hand and insert drawings with a pen input device.
In OneNote, you can mix handwriting and text on the same page with no difficulty. You can change the order of handwritten items in a list using drag and drop, and you can also add bullets and numbering to your handwritten notes and mark them with Note Flags (see the drop-down Note Flags list in Figure 8).  XE “OneNote capabilities:Finding notes" 

 XE "Finding notes" 

 XE "Finding notes:Recognizing handwritten text" OneNote treats handwriting entered on a Tablet PC XE "Tablet PC:Handwriting and drawing support"  the same as text, when it comes to search capabilities. You can use the search capabilities of OneNote to find notes entered as handwriting or text, and OneNote will find the entry either way.  XE "Ink:Finding handwritten notes" 
In meetings and lectures, you may draw a diagram to illustrate a point, or brainstorm all over the page as if on a whiteboard. If you don’t have a pen input device, you can use your  XE “OneNote capabilities:Built-in pen and ink capabilities" mouse to draw and sketch diagrams with the pen feature in OneNote, which offers a variety of ink styles to choose from, including different colors and 
thick​nesses. You can also highlight sections of notes with the pen or use the pen as an eraser. 
Convert Ink to Text
 XE “OneNote capabilities:Working with handwriting" 

 XE “OneNote capabilities:Converting handwriting to text" With OneNote on a Tablet PC XE "Tablet PC:Handwriting and drawing support"  XE "Ink:Converting to text" , you can easily convert your handwritten notes to text.
 You can convert anything from just one word to a whole section at once. To convert a word or paragraph of handwriting, select the text to convert and choose the Convert Handwriting to Text option from the Tools menu. If you want to convert an entire page of handwritten notes, right-click the page tab and choose Convert Handwriting to Text from the shortcut menu. If OneNote incorrectly converts a word, that word can be right-clicked to bring up a list of alternative words XE "How to…:Correct handwriting-to-text conversion errors" . 
Making Room for More Information
 XE “OneNote capabilities:Adding more notes" \r “AddingMoreRoomforNotes” 

 XE "Inserting space for notes" \r “AddingMoreRoomforNotes” Sometimes meeting conversations veer off on tangents and then return to the original subject. When taking notes on paper in such a meeting, you can end up with information on the same subject scattered across your page. With OneNote, you can use the Insert Extra Writing Space tool (the [image: image21.png]Move or Copy Pages

Select the section where you want o lace these pages
then cick Move or Copy.

Move pages fo:

53 203projects
= Mestings
& Tradking
& Acton Items
Current Projects
Microsoft Projects.
& Onellote Update:
2 Tablet PC Reviewer's Guide

Create New Secton... ] [ Create New Eoier...




       button on the standard toolbar) to open up space within a container in which to capture more ideas. 
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Figure 9: You can easily make space in which to capture more information in OneNote.
You can also add more room to the bottom of the OneNote page by clicking the Add Space to Page icon [image: image22.jpg]


      at the bottom of the vertical scroll bar. This ensures that your notes on one subject can all fit on the same page. 
OneNote in Action
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Jack is an example of a project manager for a large manufacturing company. He uses OneNote 2003 on his laptop to take notes during all his meetings, both in person and over the phone. Jack keeps his notes for each of his current projects in a separate OneNote notebook section, and he also keeps a special OneNote

section for meetings. He appreciates the fact that OneNote keeps all this information in one place for him. He often uses OneNote to record the audio portion of meetings, which are automatically synchronized with his typed notes. After meetings, Jack can listen to parts of his audio recording again so that he can make sure he understands important customer comments and action items that he may have overlooked during the meeting.
Capturing Notes From a Pocket PC Device or Smartphone
 XE "Pocket PC:Capturing notes from"  XE “OneNote capabilities:Capturing notes from a Pocket PC" \r "SectionPocketPCNotes" OneNote users can copy information gathered with the Notes application on a Pocket PC XE "Integration:With Pocket PC Notes"  or Smartphone to OneNote as soon as they dock the device. Each note (an individual .pwi file) on the Pocket PC becomes a separate page in the Copied Pocket PC Notes section of OneNote. 
OneNote incorporates all the content collected in the Pocket PC Notes application, including  XE “OneNote capabilities:Handwriting support" 

 XE “OneNote capabilities:Pocket PC support:Handwriting" 

 XE “OneNote capabilities:Pocket PC support:Audio recordings " 

 XE "Pocket PC:Audio recordings" 

 XE "Pocket PC:Handwriting support"  XE "Pocket PC:Conversion notes" handwritten text, typed text, text converted from handwritten to typed text and hand-drawn diagrams. OneNote converts Pocket PC ink to OneNote digital ink that can be searched or converted on a Tablet PC XE "Ink:Converting to text" . Audio recordings created using the Record button on a Pocket PC or Smartphone can be copied to individual pages in a special section in OneNote (called Copied Pocket PC Notes) for easy playback on your PC.
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Figure 10: It is easy to incorporate notes from your Pocket PC or Smartphone with OneNote.
Saving Notes
We have all experienced the frustration of searching for a particular file that we know is on our computer, but that we cannot find, either because we don’t 
remem​ber where we saved it or because we accidentally saved it in an incorrect location. OneNote has been designed to help make finding your notes as intuitive as possible.
Automatic Save
 XE “OneNote capabilities:Saving notes automatically"Paper has no need for a “save” button. Once you write something down, it’s there. OneNote offers the same kind of convenience. There is no save button in OneNote — everything is automatically saved as you write it. So if it’s necessary to turn off the computer or close the program quickly, you don’t need to worry about losing 
impor​tant information. In addition, you never have to decide where to save a particular note. OneNote automatically saves your notes in the My Notebook folder, which it creates at install time in your My Documents folder. When you next open OneNote, the application automatically returns to the last page that you modified, providing you with quick access to the notes you were working on most recently.
If you prefer, you can move sections and folders within OneNote to locations other than My Notebook, such as a network file share or another location on your hard disk drive. You can do this using Save As within OneNote and picking a new location. You can also do this by using Windows Explorer to move the appropriate .one file to the location of your choice, and then double-clicking on that .one file. OneNote will open that file and show that it is linked to a different location with a shortcut arrow on that section tab. This enables you to access .one files via the section tabs in OneNote even if those files are not saved in your My Notebook folder.
Protecting Section Content
 XE “OneNote capabilities:Password protection"

 XE “OneNote capabilities:Security"

 XE "Security"

 XE "Passwords"You can protect sensitive sections of your notebook with passwords. Using OneNote section protection causes OneNote to encrypt your specified .one section files. When you try to access a protected section, you must first enter your password to view the page contents. 
OneNote keeps your password in memory so that you do not have to re-enter it every time you go back to the section. If you leave OneNote for more than a specified |
pe​riod (the default period is 10 minutes, but you can configure this in OneNote 
prefer​ences), OneNote relocks protected sections, and you must re-enter your password to open those sections.
OneNote in Action

[image: image24.emf]
Walter is an example of a staff researcher for a major travel magazine. He uses OneNote 2003 on his desktop PC to take notes and gather information about new destinations for upcoming articles. He keeps a separate OneNote notebook section for each destination. Walter 

often uses the OneNote ability to simply drag pictures, text or other information from a Web site directly into OneNote — and OneNote even conveniently notes the URL for him so that he can easily reference his sources later.

Organize Information More Effectively
Capturing information effectively is only one part of the complete note-taking picture. The more notes you have, the more you need to keep them well-organized. When you keep your notes on slips of paper or in spiral-bound notebooks, your ability to organize your notes is limited. You can’t reorganize the pages of a spiral 
note​book without tearing the notebook apart. If you keep notes in multiple notebooks or in multiple locations (in the hundreds of files on your computer, in your personal digi​tal assistant or in your planner, for example), your ability to keep your notes organ​ized is even more greatly compromised. There are simply too many places to look, let alone keep each of those places organized. 
By contrast, when you keep your notes in OneNote, your ability to organize your notes is unlimited. You can keep all your notes in one place and organize your notes any way you like, which makes it easy for you to access the right information at the right time to create reports, prepare presentations, organize for important meetings or study for tests. 
Meet the OneNote Interface
 XE "OneNote features:Interface features" \r "OneNoteInterface" The flexible interface of your OneNote digital notebook lets you create as many XE "What are…:Folders” \r “ContainerHierarchy”  
fold​ers,  XE "What are…:Sections” \r “ContainerHierarchy”sections and XE "What are…:Pages and subpages” \r “ContainerHierarchy"  pages as you need, while keeping them all in one convenient place. And no matter how you decide to organize information, you can easily search across all your notes to quickly find all the information you want.
As noted on page 2 of this guide, you can click anywhere on the OneNote page 
sur​face and start taking notes instantly. But what is a OneNote page, and what are its key features? Let’s take a look — and while we’re at it we’ll distinguish between OneNote pages, sections and folders, all of which are simply different kinds of containers for organizing your notes. 
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The Hierarchy of a OneNote Notebook
 XE "OneNote features:Hierarchy of page containers"  \r “ContainerHierarchy”The hierarchy of a OneNote Notebook is simple enough to describe (see Figure 11). Pages reside in sec​tions, which reside in folders. A folder can contain multiple sections; it can also contain other folders (which can contain other sections and folders). 

Figure 12 identifies the different areas of the OneNote interface.  XE "Interface features:Section, folder, page, and subpage tabs"  Folders and sections appear as colored tabs on the top portion of the OneNote page surface. The pages and 
sub​pages in a given section appear as tabs along the vertical axis of the OneNote page surface.  XE "Interface features:Drop-down list of folders and sections" You can always see the complete hierarchy of your folders and sec​tions by clicking the drop-down list on the left side of the section/folder tabs row (note that the drop-down list does not display individual pages and subpages).
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Figure 12: What's where in the OneNote interface
The Page Header
 XE "Interface features:Page header" You can name a page by entering a title in the Title Well of the page header, that color​ful region at the top of the page that does not scroll with the main page contents (see Figure 13). The  XE “How to…:Name a page” page names appear in the page tabs running vertically to the side of the OneNote page surface. If you do not create a title for the page, the default name for the page will be the first text or handwritten note that you enter on the page. 
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Figure 13: The OneNote page header is found at the top of the page surface.
The page header serves other purposes, too. In a long meeting or lecture, you may capture a page of notes that extends beyond the available screen area. In such a situation, it can be hard to keep track of the information or notes to which you want continu​ous access, such as follow-up questions. The page header helps you overcome this issue. As a region that does  XE "Interface features:Scrolling and non-scrolling regions" not scroll with the page contents, the page header provides a perfect container for the collection of questions or notes you want to keep in front of your eyes at all times. You can resize the page header area, and you can enter notes in the colored area of the page header using the same rich word- processing features that you use in other note containers on the scrolling portion of the page. Just click there and type or write your notes by hand. 
Page Tab Features
[image: image26.emf]Along the right side of the OneNote page display, there are tabs for the individual pages within each notebook section.  XE “How to…:Go to a page” Clicking on a tab takes you to the corresponding page. Hovering the mouse or pen over these page tabs will quickly give you infor​mation for each page, including the page title and date created. You can also select multiple pages using page tabs.
Just as you flip (or "riffle”) through  XE “How to…:Flip through note pages” paper notes to find the one page you are looking for, you can do the same with OneNote pages. This riffling action is recreated in OneNote when you hold down the mouse button and drag up or down over the page tabs.
By clicking the arrow button in the lower right-hand corner of the OneNote page 
sur​face (directly below the page name tags) you can choose whether to display the pages by the  XE “How to…:View page numbers” 

 XE "Page names vs. page numbers" 

 XE "Interface features:Named or numbered pages" names entered in the page header region or, in a narrower format, by page number (see Figure 14). You can move your page tabs to the left of the page if you prefer by clicking Options on the Tools menu, choosing the Display category in the Options dialog box, and checking  XE "Interface features:Left or right page tab orientation" Page tabs appear on the left. This is particularly useful if you are a left-handed user of a  XE "Tablet PC:Positioning page tabs" Tablet PC. You can also resize the page tabs by dragging the border between the tabs and the OneNote page surface to the right or left.
Notebook Section and Folder Tabs
Near the top of the screen are tabs representing the sections and/or folders within your OneNote notebook, which are much like tabs of hanging file folders or sections in a three-ring binder.  XE “How to…:Access folders and sections” 

 XE "Interface features:Nesting folders and sections" You can create as many sections and folders as you need, and customize them by naming them after different projects, courses, types of meet​ings or anything you want. For example, project managers might have a notebook section for meeting notes and additional sections for each project that they are working on. Or, they might have a notebook folder for a particular project and a section for each component of the project (for example, vendor meetings, client meetings and project timelines).
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Figure 15: Organize different types of notes in notebook sections that you define.
However you decide to organize your notes, each notebook section exists in your My Notebook folder (or one of its subfolders) as a distinct OneNote file with the .one extension. You can change the location of your notebook and store all or portions of it on a server, in case you want to work on a section of notes with a colleague, as you would with a shared notebook or logbook.
Stationery
 XE “How to…:Use built-in or custom stationery” \r “Stationery” 

 XE "Stationery" \r “Stationery” 

 XE "Interface features:Stationery" \r “Stationery” When you launch OneNote, a blank white page opens by default. However, there are also stationery styles — pages with predefined looks. OneNote offers many kinds of built-in stationery:
· Planner formats for meetings and lectures
· Decorative formats, providing a variety of stationery styles to match your mood
· Business formats for meetings and presentations
· Academic formats for capturing lecture notes in a variety of disciplines
· Blank formats in a range of standard paper sizes such as letter, A4, billfold and index cards. Using blank paper sizes as your stationery helps ensure that your notes will print out correctly on the corresponding paper size.
· Tablet PC Portrait formats for meetings and lectures  XE "Tablet PC:Stationery" 
· Tablet PC Landscape formats for meeting and lectures
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To choose a stationery style, go to the File menu and select New, then click New From Stationery in the New task pane. You can then choose the stationery you want from the Stationery task pane (see Error! Reference source not found.). You can identify a specific piece of stationery to be your default stationery in the Choose default stationery field near the bot​tom of the Stationery task pane. You can also create a completely new layout on your page and save that layout as stationery through the Create new stationery link at the bottom of the Stationery task pane. 

 XE “How to…:Create stationery”

 XE “How to…:Define a default stationery”To create a new page quickly using a recently-used stationery type, click the arrow at the end of the new page button (see Figure 17). This pulls down a list of options for new page creation, including a list of recently-used stationery pages.

.
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Figure 17: Clicking on the arrow of the new page button provides quick access to stationery.
Stationery pages give you a consistent look in all note-taking sessions, make typing recurrent text (such as the word “attendees” in every meeting note) unnecessary, and help you achieve visually pleasing notes without needing to format layout and font styles every time.
Microsoft makes new stationery available on the Microsoft Office Online site at http://office.microsoft.com/home/default.aspx. You can download new stationery and add them to your favorite stationery to make OneNote work exactly the way you want.

Organizing With Subpages, Sections and Folders 
 XE “How to…:Organize using subpages” As you take notes in OneNote, your pages will expand to accommodate your notes. However, once you have a taken a large amount of notes devoted to one subject, you will have a very long page of notes. You may find it useful to divide that information among several related pages of notes. You can do this with a  XE "OneNote features:Subpages" 

 XE "Interface features:Subpages" subpage, which is a distinct page that is linked directly to the page you are viewing. Subpages even share the primary page’s page header. If you are in a long 
presen​tation, for example, you might create individual subpages for taking notes on the mate​rial presented by different speakers. 

You can create a subpage by clicking the New Subpage tab on the side of the OneNote page display. You can also create a subpage using the New Subpage option on the Insert menu. Among the page tabs on the side of the OneNote display, subpages appear as shorter tabs beneath the primary page tab. Because the 
sub​page shares the page header with the primary file, there is no distinct title well for a subpage name, so subpages take their names from the first words entered into the uppermost note container on the subpage.
Sections for Multiple Pages

 XE “How to…:Organize using sections” 

 XE "OneNote features:Sections" 

 XE "Interface features:Sections" As you create more pages of notes, you will probably find it valuable to separate them into different sections, much as you might add sections in a three-ring binder or hanging file folders to your file cabinet. You might have a section for each 
pro​ject, one for each course or one for each type of meeting (for example, client presen​tations, internal brainstorming and weekly team meetings) — you can structure your sections the way you prefer. You can create new sections by clicking New Section on the Insert menu or by right-clicking any section tab and choosing New Section.
Folders for Multiple Sections
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 XE “How to…:Organize using folders” 

 XE "OneNote features:Folders" 

 XE "Interface features:Folders" Folders provide yet another way to organize information in OneNote. When you have created a large number of notebook sections, it can be advantageous to create 
fold​ers to store related sections. For example, you may want to create a folder for a pro​ject and then move all the sections related to that project into that folder, so that you have one project folder containing separate sections for your client meetings, proposals, budget, timeline, phone notes and more (see Figure 18). The OneNote folder structure is similar to the folder structure within Microsoft Windows Explorer, allowing you to  XE "Interface features:Nesting folders and sections" create folders within a folder to further subdivide your sections.
Notebook folders and sections created in OneNote are automatically saved to a  XE "Interface features:My Notebook" My Notebook folder found inside the My Documents folder on your computer. You can access all the information saved to My Notebook through the intuitive interface of OneNote. Each .one file will always be represented as a separate section tab in OneNote. This makes it easy for you to access information for multiple projects without needing to remember where you saved specific files in your computer. 
Moving Pages, Sections and Folders
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 XE "Moving pages, sections, and folders" 

 XE “How to…:Move a page, section, or folder” To reorder your pages within the same section — for example, moving the last page to the beginning of the section — just select the page tab, drag that page or page group left or right to get it out of the “stack,” and then drag it up or down to the new location.
To move pages from one section to another, right-click the page tab, choose Move Page To, and choose the name of the section to which you would like to move that page. Each time you do this, OneNote 
remem​bers where you have moved previous pages and suggests those locations the next time you move a page.
Reordering sections within the same folder is simply a matter of a few clicks. For example, if you have sec​tions A, B, C and D, and you want to move D, right-click the section tab for section D, and choose Move. Then click on section A. This action will move section D so that it appears to the right of section A, and your notebook will be organized as sections A, D, B and C.
To move sections from one folder to another, follow the same steps, but click the name of a folder instead of a section.
To move your folders, open up the My Notebook folder in Windows Explorer, and move the folders where you want them.
Closing Sections and Folders
 XE "Closing sections and folders" 

 XE "Archiving notes" 

 XE “How to…:Close a section or folder” If you collect so many notes that you find you want to get some of them out of the way temporarily, or you don’t think you will need them for a long time, you can close them. This retains the section or folder in your notebook but hides it from view so it is not searched.  XE "Finding notes:In closed folders or sections" 

 XE "Closing sections and folders:Finding notes in" To get it back, you can open the section or folder using Open or Open Folder options on the File menu. 
Note: Although it is common to close files in other document-oriented applications, that is not the common practice with OneNote. Closing sections and folders effectively removes them from the active OneNote knowledge base — and that makes it harder to find information quickly. By keeping OneNote sections and folders open, you can access them quickly whenever you want. 
Deleting Sections and Folders
 XE "Deleting:Sections and folders" 

 XE “How to…:Delete a section or folder” You can delete a section or folder by right-clicking the section or folder tab and choosing Delete. When you delete an entire section of your notebook, you have 
de​leted a OneNote .one file. It goes to the Recycle Bin on your desktop. You can move a deleted section from the Recycle Bin back into your My Notebook folder, as long as you have not emptied your Recycle Bin.
To restore an entire section or folder, open up the Recycle Bin on your desktop. Find the appropriate OneNote file, and right-click it. Choose Restore.  XE “How to…:Restore a deleted section or folder” 

 XE “Restoring deleted sections or folders" 
Deleting Pages

 XE "Deleting:Pages" 

 XE “How to…:Delete a page” You can delete a page by right-clicking its page tab and choosing Delete. 

When you delete a page, it goes to a section called Deleted Pages. You can move a deleted page back into a section in your notebook as long as you have not emptied this Deleted Pages section. To restore a deleted page, click on the drop-down tab on the left-hand side of the top page margin (the one naming the folder in which you are currently working). This drop-down list reveals the entire folder and section struc​ture of your OneNote files. Clicking on the small recycle bin icon called Deleted Pages at the bottom of the list opens up all your deleted pages by section. To restore any page or page group, right-click the page tab and choose Restore.  XE "Deleting:Restoring deleted pages" 

 XE "Restoring deleted pages" 
Organizing Notes on the Page
In addition to enabling you to organize your notes among different folders, sections and page groups, OneNote also provides a number of tools to help you orga​​n​ize your notes on each page.
Resizing Note Containers on a Page
 XE "Interface features:Resizable note containers" 

 XE “How to…:Resize a note container” The handle on top of each note container also has two small horizontal arrows in the upper-right corner. These arrows enable you to resize that container of notes, so that you can easily make those notes into tall thin columns or long horizontal rows.
 XE "Interface features:Expandable note containers" 

 XE “How to…:Add to an existing note container” 

 XE “How to…:Split notes into a new note container” When you click on or near an existing note container, OneNote will enable you to add additional notes to that container. To start a new container of notes, click about an inch away from any existing note containers. Dragging and dropping one note 
con​tainer on top of another one will combine the notes within those containers into one large note container. This is useful when arranging ideas and making lists.
Reorganizing Notes Within a Container
Another way to rearrange your notes is by selecting specific paragraphs in a note container and moving only those paragraphs. You can do this either by using the 
ar​row keys on your keyboard to select specific paragraphs of text to cut and paste, or by hovering your mouse cursor over a paragraph within a container of notes. When you hover over a paragraph, a small blue box with a cross appears to the left of the paragraph. You can use this box as a “paragraph handle” by clicking on it and then dragging and dropping that paragraph of notes anywhere on the page. If you drag it on top of another container of notes, you will add it to that note container; if you drag it to open space on the page, you will create a new note container with that 
para​graph of notes.
Organizing With Bullets, Numbering and Outlining
 XE “How to…:Use bullets and lists”You can easily add bullets to visually separate items in a list and draw attention to specific entries, or use numbers to show a sequence. With OneNote, you can even combine bullets and numbers in the same list.
OneNote automatically recognizes different types of outlines as you create them, such as a simple list of phrases, a series of bulleted paragraphs, or the traditional number and letter hierarchy of headings. Because this function is automated, you can concen​trate on the information you are taking down, rather than how to format it. OneNote also allows you to expand and contract multiple levels of an outline, as well as customize the number format of outlines.  XE “How to…:Outline notes” 
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Figure 20: Outline your notes easily with OneNote outlining features.
In addition, the strict outline structure of OneNote ensures that subbullets are never indented more than one level underneath the preceding bullet. This makes dragging and dropping a paragraph into an outline easy, because that paragraph can only take one of three possible positions: the same as the preceding bullet, one bullet point out from the preceding point, or one bullet point in from the preceding point. Again, 
be​cause OneNote automates this process and makes simple organizational decisions for you, you can concentrate on capturing and manipulating your ideas. 
Keyboard Shortcuts
Special consideration was put into making OneNote work well for people who prefer to work with the keyboard. Convenient keyboard shortcuts are available for all 
com​mon operations. A complete list of keyboard shortcuts is available by searching for Keyboard Shortcuts in the OneNote Help system.
Keeping Track of Important Notes
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Finding Notes
 XE “How to…:Find notes”  XE "Finding notes" \r "FindingNotes" 

 XE "Finding notes:Sorting found notes" The Find feature in OneNote helps you keep track of important notes. When you enter a keyword in the Find box at the top of the OneNote page display, OneNote instantly locates the notes containing those keywords — and not just on the page in front of you, but on any page in any section and in any folder that is currently open in your notebook.
 You can also limit the range of your search using the Search In pull-down menu (see Figure 21).
OneNote also highlights in yellow the page tabs that contain matches to your search query (see Figure 22). When you press Enter or click on the “next match” arrow, OneNote jumps quickly to the next match in the notes, across any notebook section, making it easy to search across multiple sections at the same time.
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Figure 22: Find important information with just a few clicks.
In addition to jumping through the matches, you can click the View List button. OneNote will display a list of the OneNote pages containing the search term. By default, these results are grouped by section order, but they can be regrouped by date or title by clicking the Date or Title buttons in the Page List Task Pane.
Note Flags
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 XE “How to…:Flag notes for follow-up” As discussed on page 2, OneNote has a set of Note Flags that can be used to mark key items, urgent notes or notes that require follow-up. You can customize icons and names for your Note Flags, apply any combination of font color and high​lighting to a Note Flag, and add check boxes to appear next to the note. 

In addition to prioritizing and marking notes, you can use Note Flags to organize your information. The Note Flags Summary Task Pane makes it easy to manage and view all the items you have flagged with Note Flags, which can be viewed by page, notebook section or across all notebook sections. The Note Flags Summary Task Pane shows links to all the notes that you have marked with Note Flags and presents management features that allow you to prioritize items and take whatever action is needed. 

Clicking a flagged note in the summary pane takes you to that note in your notebook sections. In this way, you can navigate through notes according to the flags. For example, you could customize a Note Flag as a “supervisor” flag and after a meeting call up all the action items your supervisor had mentioned. 

History Navigation
 XE “How to…:Move between notes” 

 XE "Note history navigation" 

 XE "Back button" 

 XE "Forward button" With the many ways to navigate through OneNote and locate information, it’s 
impor​tant to have an easy way to get back to pages that you have viewed recently. OneNote tracks all the pages visited across all notebooks — just as a Web browser tracks all the Web pages that have been visited. And just as in a browser, you can move backward and forward through these pages by clicking Back and Forward in the upper-left corner of the program. The history is cleared each time the program is closed.
OneNote in Action
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Roxanne is an example of a first-year college student. She uses OneNote 2003 on her laptop to take notes in class and to prepare for exams. Roxanne keeps a separate OneNote folder for each school term, and in each folder she has distinct OneNote sections for each of 

her classes. When the term ends, she creates a new folder to hold a new set of notes. She particularly likes the fact that OneNote enables her to flag important sections of her notes and then lets her find all her Note Flags across every class notebook section, so she doesn’t forget an assignment for other classes — or forget to call mom!

Share Information Easily
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 XE "OneNote capabilities:Sharing notes" \r "SharingNotes" 

 XE "Sharing notes" \r "SharingNotes" Too often, the notes that you have captured on paper just sit in stacks with all your other papers because sharing them requires time and effort to copy or enter them into another program. With OneNote, you have several easy ways to share important information and ideas more effectively, including sharing through e‑mail, sharing by 
publi​shing notes to a Web site or SharePoint site, or by publishing your notes as an HTML or Word file XE "Integration:With Microsoft Office Word" . 

What’s the best way for you to share your notes? OneNote even helps you figure that out. When you click Share With Others on the File menu, OneNote opens a Task Pane that helps you share your notes using e-mail or a real-time session, or by publishing your notes to a remote location.

Sharing Notes Using E-Mail
 XE "OneNote features:Sharing notes:Using e-mail" By clicking the e‑mail icon        on the toolbar (or using the E‑mail option from the Share with Others command on the File menu), OneNote users working with Microsoft Office Outlook® 2003 can share their notes with others. OneNote creates a special  XE "File formats:.one" .one file consisting of copies of your selected pages and attaches the .one file to the message. It also automatically formats the information on the page (including graphics
) as HTML code and puts it in the body of the e‑mail message — so even recipients who don’t have OneNote can read the information (see Figure 25). If a page has linked audio or video files, OneNote also attaches a copy of these to the message if you have elected to do this in Tools/Options.  XE "OneNote features:Sharing notes:Sharing audio and video" E‑mail message recipients who have  XE "Integration:With Microsoft Office Outlook" OneNote can double-click the .one file attach​ment and add that page to their own notebooks in a special section called Notes E‑mailed to Me. 
 XE "Interface features:Notes e-mailed to me" OneNote users with older versions of Outlook or other e-mail programs can still send OneNote notes to other e‑mail recipients by attaching the .one file to the message manually. Neither older versions of Outlook nor other e‑mail programs will convert the notes on the OneNote page to HTML for inclusion in the body of the message, but you can still copy and paste your notes into your e-mail program.
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Figure 25: Sharing notes through e-mail is easy with OneNote.
Publish Notes to a Web Site or Windows SharePoint Services Site
 XE "OneNote features:Sharing notes:Using SharePoint" 

 XE "OneNote features:Sharing notes:Using the Web " You can easily share your notes with others in a read-only form by publishing your notes in single-file Web page form that others can view with a Web browser or open and edit in Microsoft Word XE "Integration:With Microsoft Office Word" . Using the Publish Pages option on the File menu, you can create a copy of your  XE "File formats:HTML" OneNote page as an  XE "File formats:.mht" .mht format file (a format that includes not only the HTML code but also all the graphics in a single file) and post it on a file share, Web site or Microsoft Windows SharePoint Services site. You can even send the .mht file to others as an e‑mail attachment. As when sending a page using e‑mail, OneNote converts handwriting and drawings into pictures when it publishes the note page in HTML format.
If you want to post your notes in a location where others can access them as OneNote notes, you can use the Publish Pages option and select the OneNote Sections format to make a copy of the current page as a .one file in a shared 
loca​tion, such as a file share or Windows SharePoint Services site. Yet an easier way is to use the Share With Others option from the File menu. You can select a file server or SharePoint site and move your note section to that location, where others can open it. Alternatively, you can select to publish as a Microsoft Word file  XE "Integration:With Microsoft Office Word" if others do not have OneNote.
 XE "OneNote features:Sharing notes:Shared workspaces" OneNote also provides a Shared Workspace Task Pane that you can use to create tasks, work on related documents and more in a shared OneNote notebook that is saved on a Windows SharePoint Services site. Shared Workspaces provide intelligent document collaboration capabilities, improved version control, the ability to share information about docu​ments in near real time, assign tasks and deadlines, and easily review the status of a document project. OneNote shares this feature with many other Microsoft Office System programs. For more information about this feature, please see the product guide for the newest edition of the Microsoft Office System, available at http://www.microsoft.com/office/.
Real-Time Sharing in OneNote 
 XE "OneNote features:Sharing notes:Real time sharing" You can share your notes and drawings with others — and see their comments and additions, all in real time — using the Shared Session feature of OneNote. You can create or join a peer-to-peer network session in which multiple users can interact on shared OneNote pages using the Share With Others task bar or by clicking Shared Session in the Tools menu. 
 XE "OneNote features:Sharing notes:Real time sharing:Interactive" 

 XE "OneNote features:Sharing notes:Real time sharing:Broadcast" 

 XE "OneNote features:Sharing notes:Real time sharing:Inviting participants" OneNote makes it easy to invite other people to join a session. OneNote creates an e‑mail message that you can use to invite participants. By clicking on the link in the body of the e‑mail message, the people you have invited can join the shared session. For example, you’re in a teleconference and need to draw a diagram to explain to the other person what you are thinking. If both of you have OneNote, you can work together on the shared note surface, using it like a combination notebook and whiteboard. Each of you will see the other’s drawings and notations in real time, which adds a powerful dimension to the phone conversation. You can invite as many people as you like — 20 or more is quite possible — in various locations to work together. 
OneNote also provides the ability to broadcast note sessions to other OneNote users,  so you can share your notes in real time without giving others the ability to interact with your notes. At the end of a shared session, whether broadcast or interactive, each user retains a copy of the shared notes as part of his or her notebook, so there’s no need to take a record of what was discussed.
Integration With Microsoft Office
 XE "Integration:with Microsoft Office" Microsoft Office OneNote 2003 is a member of the Microsoft Office System, but it can be used even if no other Microsoft Office System programs are installed on your 
computer. However, if you do have a version of Microsoft Office 2000 or later installed, OneNote can take advantage of its powerful features.
· Clipboard integration enables you to copy and paste freely between OneNote and other Microsoft Office programs.
· You can create tasks in Outlook 2003 from within OneNote. You can also create Outlook Appointments and Outlook Contacts by selecting the infor​mation in your notes and clicking the Outlook button      on the Standard toolbar.  XE “How to…:Create Outlook tasks”  XE "Integration:With Microsoft Office Outlook" 
·  XE "OneNote features:Integrating Outlook meeting details" 

 XE “How to…:Add Outlook meeting details to a note” You can also import Outlook Meeting Details to a OneNote page. When you attend a meeting that is in your Outlook Calendar, you can click choose Outlook Meeting Details from the Insert menu in OneNote, verify which meeting you are in, and automatically add to your notes the meeting details (such as the attendee list, meeting title and location, and the agenda, if any). This lets you get started right away with your own notes.
· Integration with Outlook 2003 enables you to click the e-mail icon within OneNote and e-mail your notes as both an attachment and as HTML in the body of the 
e-mail.  XE “How to…:Send a note using e‑mail” 
· OneNote shares dictionaries and AutoCorrect lists with other Microsoft Office System programs so that any words you add to your custom dictionary or Auto​Correct list in Word will be recognized within OneNote as well.  XE “How to…:Take advantage of other Microsoft Office features”  XE "Integration:With Microsoft Office Word" 
· There is an Ifilter for OneNote files so that they can be searched with SharePoint Portal Server V2.0.  XE "Integration:With SharePoint" 
· You can create a shared team notebook section using Microsoft Windows SharePoint Team Services.
· You can place notes on your own site or a team site on SharePoint Portal Server V2.0 or Windows SharePoint Services, which causes the Shared Workspace Pane to appear within OneNote while you are in that section. 
· You can send the information on a notes page directly to Microsoft Office Word 2003. XE "Integration:With Microsoft Office Word"  Pull down the File menu, click Send To and select Microsoft Office Word. This will cause OneNote to copy your notes directly into a Word file, which facilitates an easy transition from note-taking and outlining to full-featured document creation. You can also use the Save As option on the File menu to save your notes as a Word file.
Adding Other Documents to Your Notebook
OneNote also makes it easy to incorporate documents from Word, presentations from PowerPoint and worksheets from Excel into your notes XE "Integration:With Microsoft Office Excel" 

 XE "Integration:With Microsoft Office PowerPoint" . You can also import text files, as well as  XE "File formats:TIFF" TIFF and other generic image file types.
 To incorporate a docu​ment into a OneNote page, use the Document as Pictures option on the Insert menu. This effectively “prints” the document into your OneNote notebook. You can then refer to the pages that result and take notes on or beside them. This is an ideal way to annotate PowerPoint handouts or Word or Excel documents.  XE "Printing notes" 

 XE "OneNote capabilities:Printing notes" 

 XE "How to…:Print notes" 

 XE "Printing notes:With Microsoft Office  Document Image Writer" For other docu​ment types, you can print the files to the Microsoft Office Document Image Writer — which OneNote installs as a printer option — and generate a single-page .mdi format document or a multipage .tiff format document that you can then insert in OneNote.
You can also create a link to a file simply by dragging the file from your desktop to a OneNote page XE "Linking to other files and websites" . OneNote offers you the option of inserting a document as a picture (as described above, for Microsoft Office file types). It also offers to create one of two kinds of links. You can link to the actual document in its original location (which is handy if the document is still in development; clicking the link will always open the latest version of the document). OneNote also gives you the option of making a copy of the document in your OneNote section folder and linking to the copy of the docu​ment (which is useful if the original document is stored on a location you might not be able to access in the future). Either way, if you choose to insert a link to the document on your OneNote page, you can click the link from within OneNote and open the file in its native application — where you can read or modify the file as necessary.

OneNote in Action


Abby is an example of a consultant for a leading 
profes​sional services firm. She uses OneNote on her note​book PC to keep track of her client notes, meetings and phone calls. Abby particularly values the fact that OneNote makes it very easy to share her notes with her 
colleagues using e-mail or their team’s Microsoft Windows SharePoint Services site. This enables her entire team to share ideas and reuse each other’s notes and information easily and efficiently.

Printing Notes
You can print your notes in OneNote by choosing Print from the File menu. OneNote helps ensure that your notes fit to the correct paper size by scaling your notes to fit the width of paper you are printing on. You can control this by clicking Print Preview on the File menu and then selecting Scale content to paper width — or by setting the correct paper size with Blank Paper stationery before you begin taking notes. If you are using stationery, OneNote prints the stationery along with your notes. 
OneNote in Action


Scott is an example of an engineer who designs circuits and chips for a high-tech company. He uses OneNote 2003 on his desktop PC along with a pen input accessory to take notes and draw diagrams for his various projects and meetings. Because all of Scott’s 
notebooks are in one place, it’s really easy for him to search his notes quickly to find information. For example, Scott’s man​ager just asked him for the price quote for a new alloy that he is currently investi​gating. Scott knows that he took down this quote for the alloy several weeks ago, but he doesn’t remember exactly where or when. By searching for the word “alloy” in his OneNote notes, Scott can find this information with a few clicks of his mouse.
System Requirements
To run Microsoft® Office OneNote™ 2003, your computer must meet the following minimum requirements:

· Personal computer with a Pentium 233-megahertz (MHz) or higher processor, Pentium III recommended. 
· 128 megabytes (MB) of RAM or more recommended. 
· 100 MB of available hard disk space for a default installation. Optional installation files cache (recommended) requires an additional 100 MB of hard disk space. The hard disk space requirement also varies according to the components you choose to install and the amount of data you store in OneNote. 
· Microsoft Windows® 2000 with Service Pack 3 or later; or Windows XP or later. 
· Super VGA (800 × 600) or higher-resolution monitor. 
· CD-ROM or DVD drive. 
To use all of the features available in Microsoft Office OneNote 2003, it is recommended that you have the following additional items and services:

· Office integration features require programs in the Microsoft Office System, including Microsoft Office Outlook® 2003. 
· Advanced collaboration features require Microsoft Windows Server™ 2003 running Microsoft Windows SharePoint™ Services. 
· Some inking features require that you run OneNote on Microsoft Windows XP Tablet PC Edition. For enhanced inking features, Windows XP Tablet PC Edition 2005 is required. 
· Audio recording of notes requires a microphone, an audio output device, Windows Media® Player 8.0 or later, and DirectX® 8.1 or later. Windows Media Player 9.0 or later and DirectX 9.0b or later recommended. 
· Video recording of notes requires a video capture device, Windows Media Player 9.0 or later, and DirectX 9.0 or later. 
· The Shared Sessions feature requires an Internet connection, DirectX 8.1 or later, (DirectX 9.0b or later recommended), and a router that supports Universal Plug and Play (UPnP). 
· Insertion of digital pictures requires a TWAIN-compatible digital camera or scanner. 
· Copying notes from a Windows Mobile-based Pocket PC or Smartphone requires ActiveSync® 3.7.1.4034 or later. 

 XE "Video support:System requirements" 
Additional Resources
Visit http://www.microsoft.com/office/onenote/, where you will find much more information about OneNote, including a detailed Frequently Asked Questions document, a full community site, newsgroups where you can ask questions and give feedback to fellow OneNote users, and chat sessions with the OneNote product team.
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Figure � SEQ Figure \* ARABIC �11�: Folders, Sections and Pages in OneNote
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Figure � SEQ Figure \* ARABIC �14�: You can choose to display page names or page numbers in OneNote
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Figure � SEQ Figure \* ARABIC �18�: Folders enable you to organize multiple sets of notes.
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Figure � SEQ Figure \* ARABIC �19�: You can reorder OneNote sections with a few clicks of the mouse.





OneNote in Action


��and he also keeps a special OneNote section for meetings. He appreciates the fact that OneNote keeps all this information in one place for him. He often uses OneNote to record the audio portion of meetings, which are automatically synch-ro�nized with his typed notes. After meetings, Jack can listen to parts of his audio recording again so that he can make sure he understands important customer comments and action items that he may have overlooked during the meeting.





OneNote in Action





� INCLUDEPICTURE "cid:image002.gif@01C40DCD.A29CD360" \* MERGEFORMATINET ���


Figure � SEQ Figure \* ARABIC �21�: With OneNote you can search for any text, anywhere in your notebook.
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Figure � SEQ Figure \* ARABIC �23�: You can keep track of all important notes and To-Do items in one place in OneNote.
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Figure � SEQ Figure \* ARABIC �24�: OneNote helps you determine how best to share your notes with others.
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Figure � SEQ Figure \* ARABIC �16�: The Stationery task pane








� If you are using pen input devices with OneNote on your desktop or laptop, your handwritten notes are saved as picture files. These notes will not have the enhanced features of digital ink, such as bullets and numbering or the ability to search them with the Find feature. These notes also cannot be converted to typed text.


� The OneNote Find feature does not search sections or folders you have archived with the Close command on the File menu. You can also narrow your search scope to a specific page range.


� Handwriting and drawings in the notes are converted into picture files in the body of the e�mail message, but they retain their characteristics as handwriting and drawings in the attached .one file.


� Documents imported into OneNote cannot be edited, but they can be annotated.


� Opening a linked document in its native application requires that you have access to that native application.
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